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chapter 1 | Introduction

Welcome to SureThing CD Labeler - Stomp Edition, the incredible new
design tool for professional-looking CD Labels and Jewel Cases. Use
SureThing CD Labeler to design and produce all of your recordable CD
labels and jewel cases.

SureThing is easy to install, easy to learn, and fast and fun to use.

WHAT IS SURETHING?

SureThing is a new breed of utility desktop publishing software: easy,
fast, and guaranteed to produce impressive, high-quality designs every
time, whether you are a beginner or a professional designer.

We’ve done the hard part for you. We’ve had our professional
designers create hundreds of different looks for business and personal
communications; each with its own style and impression. All you do is
add your personal information and any custom finishing touches, like
pictures or logos.

SureThing includes ready-to-use templates for the world’s most
respected papers. You can see the pre-printed paper layout right on your
screen, add your own information with a click, and print your new
communications package. We call these templates SmartDesigns, because
they intelligently help manage your designs.

Use one of our SmartDesigns as is, change it as much as you want to
suit your tastes and needs, or start from scratch with your own design
ideas. Try on different looks— with the click of the mouse, you can see
how your project will look with difterent designs, different attributes, or
even a different paper stock.

When you have settled on a look that suits your tastes, print your
designs without worrying about “camera-ready” art, or expensive
typesetting hassles.

With a sleek SureThing image, and high-quality pre-printed papers,
all of your design projects are certain to impress. And it really is easy, fast,
and fun.

ENTERING USER INFORMATION

SureThing, wherever possible, will personalize your new design jobs with
information supplied. The first time you run SureThing, you will be
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asked to enter User Information. We encourage you to take a moment
and fill out the following form.

Pleferencﬁks [ x|

User Info |
il
Company: Cancel
M ame; IName Help

Tite: | Title
Address One: |Address One
Address Two: |Address Two
City: | City
State: IV ZIP: lle—
Courntry: ICountr}'
Phone One; IF'the One Fis: IFax
Phane Twa: [Phane Two E-Mail: [EM il Address

Fill in information in any of the fields which are appropriate for you.
Leave the any unnecessary fields blank (you'll have to delete the sample
text).

If this is for personal use and not associated with a business, you
might want to enter your name in place of the company name, and leave
the name field blank. This will put more emphasis on your name in
many sample designs.

GETTING HELP

SureThing has a complete help system accessible from anywhere within
the program. Much of the help is context sensitive, that is, it will jump
directly to the specific topic related to the feature or command you are
currently working with. When no specific activity is detected, opening
help takes you to the help system’s table of contents.

You can access help in a couple of ways. You can press the F1 key at
any time you are using SureThing, or you can choose Help Topics from
the Help menu for a complete listing of the available help topics.



In most dialog boxes, you’ll also see a Help button, which takes you
to the help topic for that dialog box. If you don’t see a help button in a
dialog box, remember that you can always press F1 to activate help.

CONTACTING TECHNICAL SUPPORT

If you find that SureThing is not operating correctly, you can contact us
for technical support. Before doing so, however, please first check the
User Guide and Help System. Many times you will find the answer there,
saving yourself time and the cost of a long-distance telephone call.

If you are having a problem that you think is caused by SureThing,
we would appreciate having the document file sent along with a
description of the problem. This makes mail—electronic or postal—the
best option for technical support.

If you do need to contact us for technical support, you have the
following options:

World Wide Web — www.mvd.com

If you have access to the Internet, this is definitely your best option. Our
Web site is kept current with answers to frequently asked questions
(FAQs), program updates, and fresh ideas for using SureThing. You can
also e-mail us directly for an immediate response to your questions. Visit
us on the World Wide Web at: www.mvd.com.

E-mail

You can send us e-mail by visiting our web site, or send it directly to:

support@mvd.com

Fax or mail
You can mail or fax questions to us at:

MicroVision Development
P.O. Box 3010
Carlsbad, CA 92009

Fax: 760.438.7406

| 3
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Telephone

You can also phone us directly. Before calling, please have your customer
number ready, and a complete description of your problem written
down. Also, please do not call the Order line, as the operators will not be
able to help you with technical problems, or offer any advice on using
SureThing. The number for technical support is:

760.438.0305

THE SURETHING USER GUIDE

This User Guide was created entirely with WordExpress® running under
Windows 9s. The typeface Bergamo, included on the companion CD
from Sean Cavanaugh’s book Digital T'ype Design Guide (ISBN 1-56830-
190-1) was used for all body text. The typeface Myriad, a Multiple Master
font from Adobe, was used for folios, section headings, and captions.



chapter 2 | Creating a Design

In this chapter, we’ll create a label design, edit the text, print it, and save
it to disk. The techniques used are the same for any paper product, so
you can follow along with our examples and instructions no matter what

type of product you are creating.

To create a Design, choose New from the File menu. The New

Design dialog box appears:

Hew

SmartDesigns | Databases |

Product Type: I [&ll Types) j
SmartDesigns: " Sample
T3 Enwelopes =

(27 Index Products

(£ Labels - Inkjet

= Labels - Laser

(27 [sorted by product]
B2 Address
2160 Address Sup
2162 Address Bup
2163 Shipping 4-up

Lp

[ Blank Designs
N Show Background

Product Description/Compatibility:

Cancel

Help...

i

Search...

¥ Hewininday
Infarmation..
Custom...

[Elete

[l

1% 25/8in Address label. Assorted Stocks, 30 labels per sheet.

Aweery: BZE0, 5360

Maco: ML-3000, ML-3000B, ML-3025, ML-4000, ML-8101, ML-8201, ML-8301, ML-8000

Z-Lahel: 05160, 05260, 05360

SureThing categorizes the supported product types into folders. You
open folders by double clicking on them, displaying their contents. In

general, follow these steps:

0 Double-click the category folder to view a selection of product types.

® Double-click a product type folder to view the selection of specitic

Products of that type.
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® Sclect the Product from the list by clicking on its icon.
O Click OK.

‘When you have a product type chosen, the Sample in the New dialog
will visually show you what the paper stock should look like. If the paper
has a preprinted design, this will show too. Use this sample, along with
the Product Description/Compatibility at the bottom of the dialog to be sure
you are opening the correct product type for your intended use.

The example below uses an address label, Avery 5160. The Design
window appears, with the selected Product ready for editing, using its
initial default Design.

Recipient Name or Company

Alin Becipien

Shaat Adcrass
Cihy, Bhake Sp

By default, all new design projects start out with a SmartDesign for
that product type. SmartDesigns are built in templates which act like a
design assistant right inside your computer. They provide sample text, a
variety of layout choices, and even font suggestions. You'll find out more
about SmartDesigns in the following chapter.

The sample text included in a SmartDesign is designed to give you
ideas about the type of information you might use in your design. You
can, of course, enter anything you like in each field.



If you entered your User Information when you first installed
SureThing, SmartDesigns will often use this information directly.
Examples are Return Addresses, Letterhead and Business Cards. This
saves you from having to re-enter this information over and over again.

EDITING TEXT

Text in SureThing is stored in rectangular boxes called ‘text frames’.
You can have any number of text frames on a design, each of which can
be positioned anywhere on the design.

SureThing uses generic placeholders for any text and graphics that
appear on the Design. Where appropriate, the text will come from the
User Information entered in Preferences. In other cases, generic text
placeholders will provide tips for the intended use of the field such as
“Address One”, or “Company”. You simply need to replace the generic
text or graphic with your own.

To edit the text in a text frame:

©® Make sure you are using the [-Beam tool (look for the [-Beam
niouse cursor).

® Click the mouse into the field to be edited.

® Type the new text into the field. You can use the delete and
backspace keys to delete text, and the arrow keys to position the
cursor to a different location.

Moving Around in Text Frames

When editing a new design created with SmartDesigns, the text frames
(or fields) have been arranged so that filling in your data is as easy as filling
in a dialog box. Use the tab key to quickly move among the frames.

O Use the Tab key to move to the next field on the design.

® Use the Shift-Tab key to move to the previous field.

| 7
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® To completely replace the text in the field with new text, simply start
typing. To fix an error, move the cursor to the place you wish to
modify and make the change.

Moving with the tab key only works with text frames which were
created by SmartDesigns. For text frames you create yourself, You will
need to click into the frame with the mouse as described above.

PRINTING YOUR DESIGN

Printing your design is simple. SureThing manages the actual layout of
the designs on the page, and sequences them as they print. You simply
need to tell it how many copies to print, and on which label to start.

To print your design:
©® Choose the Print command from the File menu.

0 Choose the number of copies of the label you wish to print. If you
want an entire sheet of labels, check the Pages checkbox and enter the
number of pages.

® In the Sample window, with the mouse, click on the label on which
you wish to begin printing.

O Press OK.

That's all there is to it. For more information on all the options in
the print dialog box, see the chapter on

Label manufacturers do not recommend running labels through your printer once you have
peeled off any labels, to avoid damaging your printer. While this is a common practice, it is
something you should consider before doing so yourself.



SAVING YOUR DESIGN

Saving a design in SureThing is a very simple process, and one you
should do with regularity. Every few minutes is recommended. That way,
in case of a power failure or system crash, you’ll always have a recent
version of your document on disk.

To save a new document:

©® Choose the Save (or Save As) command from the File menu. The
Save File As dialog box appears.

Save As HE

Save i Iadocs j gl Ir

. Readme.dsn

File hame: | Save I
Save as lype: IDesign [*.dsh) ﬂ Cancel |
Help |

0 Seclect the drive and folder where you want the document to be saved
from the Save In list. If you want to create a new folder, click the
new folder button and enter a name for it.

® Type a name for your document in the Filename text box.

If you’re using versions of Microsoft Windows prior to Windows 95,
the Filename should be 8 or fewer characters. If you are using
Windows 95 or N'T, you can save documents with filenames as long
as 255 characters, including spaces. You don’t have to type an
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extension because SureThing automatically gives all documents the
extension DSN (unless you enter a different one).

Keep in mind that filename extensions are often hidden from view in Windows 95, depending
on how you've configured Windows. If you've changed an extension but the extension does
not appear on the desktop, it may be an extension you have told Windows not to display.

O Click Save.

The design is now saved on your hard disk with the filename you
typed, and you can return to editing it. This is the filename that you will
look for next time you want to open the document.

After you have saved your design for the first time, you will still need
to save your work periodically. Choose Save from the File menu, or press
Ctrl+S. The document is saved, with all of your updates.

Saving a document with a new filename

There are times when you want to give a document a new name, such as
when you want to edit an existing document, but keep an unchanged
copy of the original. If you were to open the document, edit it, and use
the Save command, the edited version would overwrite the old version,
so you would have no copy of the original un-edited document. The Save
As command provides a way to save your changes as well as retain a copy
of the original. After opening the original document, simply choose the
Save As command and enter a different tilename, or the same filename but
a different location.

What's Next

Now that you've gotten started using SureThing, you should be able to
create any type of specialty desktop publishing job you require. To get
the most out of SureThing, however, we recommend you at least skim
the next several chapters to learn more about SmartDesigns, Design Sets,
and setting up merge files.
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WHAT ARE SMARTDESIGNS?

SmartDesigns are intelligent templates built into SureThing, to aid you in
creating a distinctive look to your labels, business cards, or whatever.
Unlike traditional templates which simply place a few objects on a page
and leave the rest up to you, SmartDesigns allow you to modify many
aspects of the design with a few mouse clicks.

SmartDesigns are used by default whenever you create a new design
job. They provide you with sample text, a variety of layouts, design
accents to distinguish each layout, and a variety of font selections. You
do all this without creating objects or formatting text. You simply
browse the SmartDesign for a look which fits your taste, and use it.

Many times, a SmartDesign will be sufficient by itself, providing you
with a an easy method of creating a job, and getting it done fast. Other
times, you may want to add some touches of your own by using some of
the other DesignTools available in SureThing.

TEXT FIELDS IN SMARTDESIGNS

Text is organized in SmartDesigns with a series of text frames, called
fields. These text frames have special properties compared with the ones
which you can create on your own, which allows SureThing to
automatically generate new layouts, add accents to the text and change
their font.

The fields are sometimes logically grouped together. For example,
an address block may consist of an address, city, state, and zip fields. So
that they can be moved as a unit, they are grouped together. When you
select one with the Pointer Tool, you select the group.

The fields in each SmartDesign reflect the typical use for the label.
You are not required use them for such a purpose, of course, and should
feel free to use them as you require. You can even turn oft selected fields
if you find them unneeded and in the way.

You will also find special fields in SureThing for clip art and
company logos. While these are not text frames, they are still treated as
fields so that they can automatically be placed by the SmartDesign. You
may also find them grouped with other fields in the design.
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VARYING THE DESIGN WITH SMARTDESIGNS

SmartDesigns make editing a Design quick and easy. The SmartDesigns
Browser Control lets you try out difterent looks simply by browsing the
available choices. Choose a different paper stock, font, type size, design
layout, or graphic accent with one mouse click. SmartDesigns let you use
these variations in any combination, so you can choose from dozens of
great looking designs.

k I—III—HI—III—III—II

The SmartDesign Browser Controls

The SmartDesigns Browser Control, at the bottom of the screen,
contains a group of up to five individual Browser Controls. Each of these
Browsers focuses on a difterent aspect of the design. From left to right,
the controls work on the type of paper stock you are using, the general
layout of the design, accents which embellish the design, coordinated
font sets which apply across the entire design, and coordinated point
sizes.

Each of these Browsers will be described in more detail below, but
first let’s take a look at how they work. A Browser Control lets you
easily flip through the available choices available for the SmartDesign.

To operate the Browser:

O Click on the right arrow to advance to the next selection. Hold the
mouse down to continuously advance the selection.

@ Click on the left arrow to move back to the previous selection. Hold
the mouse down to continuously move back the selection.

® You can click on the text portion of the Browser to pop up a menu
with the available choices, and select a specific entry in the list.

The Paper Stock Browser

Many of the printed products are available on a variety of papers, with
difterent colors and designs. You can easily select the paper stock which



you have purchased. Itis also a great opportunity to flip through the
difterent paper stocks to see if a different one works better in getting your
1message across.

For products which are available with only a single option for the
paper stock (white labels, for instance), the Stock Browser control will
not appear.

The Layout Browser

For most product templates, there are multiple professional-looking
Layouts to choose from when creating a design. Layouts establish the
basic look of your design. They position and size text frames in relation
to the paper stock and the design philosophy. Flip through the different
layouts until you find one which best suits your tastes.

The Accent Browser

Accents are enhancements or embellishments to the selected Layout.
The Accent Browser allows you to create a number of distinctive looks
from the same basic layout. Flip through the different accents until you
find one which best suits your layout.

The Font Browser

Each layout has a set of fonts which are coordinated to bring out the best
in the designs. This is different from selecting specitic text and applying a
font just to it, in that all the text is affected, and the fonts in each text
block are coordinated with complementary typefaces. Flip through the
difterent font selections until you find one which is right for your design.

Of course, it you do have a particular typeface you want to use in a
special situation, it is quite easy to select the text and change only that
instance of the text (see the Formatting Text section of chapter 7). This
is one of the many ways SureThing makes it easy to customize your
designs.

The Point Size Browser

Because the text that appears on each design is unique, there is no one
size that fits all. For example, in a company name field a company named
IBM might look good at one point size, while MicroVision Development
would require a difterent size because of its length. Flip through the

| 13
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different point sizes to find one that matches the best with your own
information.

PLACING A LOGO OR CLIPART ON YOUR DESIGN

Some of the Accent Variations include a graphic placeholder for your
company logo. In our example of the Avery 5160 label, accent 6 has such
alogo. You just replace the placeholder with your logo to complete your
Design.

You will need a graphic file of your logo or clipart in one of the
following file formats: Windows Bitmap (.BMP), Tagged Image File
(.TIF), Paintbrush (.PCX), Window’s Metafile ( WMF), or Encapsulated
Postscript (.EPS).

To place your logo:

O Using either the [-Beam or Pointer Tool, simply double click on the
Logo Placeholder.

The New Picture window appears, for selection of a graphic file to

place:
(PRI T = 6 5 = ml s
L 15w 5 [ ool Laria IR s b P rhon b
o Pk barp o Chiz ey ¥ Raduick bap B Tagrag
|4 = cada borp e g e #F Frwr b
P 1 ey 45 Foimih fvmg F o L]
£ s b o Moy bars T e g
i Corn b 3 Lawn bap AR Thaich by
F
Fimrarw _ | oL I B -
Fetolpe  [aronen E Cwad | T Ve
b |

@ Click the Drop-down list in the List Files of Type field, and choose
the format that your logo file is in.

® Seclect the correct file for your logo in the Filename field.
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O Click OK.

Your logo graphic appears on the Design, replacing the generic logo
placeholder. The Design remains the same except for the substitution of
your logo graphic for the placeholder.

SELECTING FIELDS FOR YOUR DESIGN

Fields include such things as Name, Address, and Company Name, as
well as graphic items such as a Company Logo. If you have completed the
User Information form, wherever appropriate SureThing takes the data
from the form and places it in the design as text Items. For Items which
are not generated automatically from the User Information form, there
are generic placeholders, which you can to replace with your own text
and graphics, using the SureThing tools and menus.

You can include any, all, or none of these elements in your Design.
SmartDesigns includes all of the fields by default. If you want to specify
which fields you want to include on your Design:

® Click the Show Item button on the left hand toolbar, or select it
from the Design menu.

A window appears, listing the Items that are included with the
current Design:

Show Item

Design ltems

W Compary Logo
 Fiec: Address Block

L Ben Company Name

Cancel

i

Help...

Checked Items on the Design Items list will be included on the
Design.

@ Click an [tem to select it, click again to deselect it.
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® Click OK to return to the Design window.

The current Design is displayed with the new set of Items.



chapter 4 | Design Sets

Design Sets allow you to create and save multiple designs within a single
document. This feature allows you to print a number of unique Designs
in a single pass through the printer, without having to setup and merge
with a database first. Some examples of when you might use a Design Set
are labels for file folders, diskette labels with unique titles, and name tags.
Another example is business cards for a small company with a design for
each employee.

Learning to how to use Design Sets, and when to use them, will
greatly enhance your productivity with SureThing. It also gives you
power and flexibility which you will come to appreciate.

WHEN TO USE DESIGN SETS

There are three situations which lend themselves very nicely to the
Design Set concept. Of course, there are a lot more, but this should help
get you thinking of ways to use them.

The first is when you need to print a set of labels for more than one
item, with slight differences in the design of each. Diskette labels are a
perfect example of this usage. For example, you might have a disk
labeled March Backups - Finances, and one labeled March Backups -
Documents.

A second common use is to treat the Design Set as a miniature
database. You can create a design job with multiple designs, even though
you don't need to print them together as a set. When you need to print
one of the designs, you print only the selected design. A good example
of this is a small company doing business cards. You can create a business
card for each member of the company, and print out the cards for an
employee as they are needed.

Finally, design sets are useful for printing out multiple items of a
temporary nature in a single pass. For this example, consider file folder
labels. You can create a design job with a single design in it for your file
folder labels. When you need to generate labels for your folders, you
simply duplicate the design for each folder you need to label, and change
the title. Print them out, and you're done.

| 17
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THE DESIGN JOB BUTTON BAR

We haven't mentioned it before, but Design Job Button Bar is full of useful
shortcuts for managing your design jobs. The Design Job Button Bar
(also referred to simply as the Button Bar) is located along the left side of
each window. Itlooks like:

Show ltem

From left to right, top to bottom, the buttons perform the following:
New Design Job, Open Design Job, Save Design Job, Print Designs,
Zoom In, Zoom Out, Zoom Tool, Zoom to Fit Window, Duplicate
Design, Delete Design, Toggle Rulers, Insert Merge Field, Browse
Design Set, and Show [tem. Become familiar with this tool bar and you'll

be glad you did.

DUPLICATING THE DESIGN

The first step in creating a Design Set is the base design. You design it
just as you would any other. Once you have finished your basic design,
you use the Duplicate command to create additional designs.

We recommend finishing the basic design first because duplicating it
will then retain all your previous design work. You will only have to
make the specific changes which make the duplicated designs unique.
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To duplicate your design:

©® Choose Duplicate from the Design menu or the Duplicate button on
the Design Job Button Bar.

A window appears for you to specify the number of times you want
to Duplicate the current Design:

Duplicate Design [ X]

Mo. of Copies: IE_E L}
Cancel |
Help... |

0 Determine how many copies you want to make of the current
Design, and enter the amount in the No. of Copies field.

[ Insert at curent posiion

® If the order of the designs is critical, you may want to consider
checking the Insert at current position checkbox. Otherwise, the
duplicates will be appended to the end of the design job.

O Click OK.

You have now created a Design Set, and you will be editing the first
duplicated design. Don’t be fooled by appearances when looking at the
new design, since the new designs are duplicates of the original, they look
the same right down to the text in the fields. You are on a new design,
however, and you can start making your changes right away.

Each design in the set has its own unique data, so you can change
anything and the changes will be retained. You can even use the
SmartDesigns to create a whole different look for each design in the set if
you desire.



DESIGN SETS

20 | Chapter 4

Moving Around in Design Sets

Another way to tell which design you are editing is to look at the Design
Browser control on the Design Job Toolbar. It tells you which Design
you are currently editing, and how many are in the Design Job.

2o

W 4] o

Besides telling which design you are on, the arrow buttons allow you
to move from design to design. The arrows from left to right take you to
the first design, the previous design, the next design, and the last design.

Removing a Design

At any time, a single Design or multiple Designs can be easily removed
from the Design Job.

To remove a Design:
0 Seclect the Design.

® Choose Delete from the Design menu, or click the Delete button on
the Design Job Toolbar. The following window appears:

Delete Design(s]
Delete I El deszign(z)
starting Carcel |

with desjan |2 3 Help... |

® Enter the number of Designs to be deleted in the Delete field.

® Enter the numeric identifier (as shown on the Design Counter) for
the first Design to be deleted in the with Design field.

0@ Click OK.

The specitied Designs are removed from the page, and the remaining
Designs are replaced to fill in the spaces left by the removed Designs.
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SureThing is just as good at managing data such as mailing lists, and
indexes as it is at layout and design. Remember, though, that a lot of
times it is easier and more appropriate to simply use Design Sets instead
of linking to a merge file.

Merging data from a database file allows you to use any list of
information to compile your Design. Merge a list of names and addresses
into a Design when you want to print a set of address labels, or merge a
list of visitor’s names into a name tag Design. In fact, anytime you want
different information to print on a consistent Design, don’t waste time
retyping that existing list— just merge the data right into your design.

It is easy to incorporate data into your Design by placing a data field.
A data field is a placeholder for a piece of information that is automatically
retrieved and placed on your Design. Fields can either be standard
information such as the date, your name, or an automatic number, or
they can be a field from a separate database file.

WHERE TO MERGE FROM

SureThing allows you to merge your design with external files. This
allows you to easily create unique designs very simply. For example, if
you keep all your names and address in a Contact Manager, you can
create one design with merge fields, and create mailing labels for each
person in the Contact Manager.

SureThing comes with a simple database in which you can store
names, addresses, inventory, or anything else you may want to track. For
complex needs, you will probably want to use a more sophisticated
database.

SureThing can merge with databases in the dBASE or Comma
Delimited formats. Most database programs either directly use one of
these formats or can export a file in one or both of them for merging
purposes. The data that you put in a Design from a Database file is placed
in a Field.
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SETTING UP YOUR MERGE

SureThing offers one stop shopping when it comes to setting up a merge
in your design job. You start by bringing up the Insert Merge Field
dialog box from the Utilities menu or the Design Job Button Bar. This
command brings up the following window:

Inzert Merge Field

Company Marne

Title

Addreszz One

Address Two LI
terge File... Inzert I Cloge I Help |

Specifying a Merge File

To specify the merge file from which you are going to Merge data into
your Design:

O DPress the Merge File... button in the Insert Merge dialog box. This
brings up a standard file open dialog box in which to choose your
merge file.
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Set Merge File [ 7]

Look in: I 3 does

E test.mved

File: name: || Set I

Files of type: IMicroVision D atabage ﬂ Cancel

Help |

™ | Wiz kst recard far feld mames

[~ Clear merge file

® Click the List Files of Type dropdown list, and choose the type of

Database you are merging into your Design.

Choose from Windows Comma-Separated-Value (.CSV), DOS
Comma-Separated-Value (.CSV), Windows dBASE (.DBF), DOS
dBASE (.DBF), or a MicroVision Database ((MVD).

Refer to Chapter 10 for details on creating a MicroVision Database
using the easy SureThing Database Templates.

® Ifyou are using a CSV file and the file has been set up to use the first
record as field names, check the box which says First Record = Field
Name. If the file has not been set up in this way, you may want to
consider it in the future. It gives a CSV file meaningful names to use
when inserting the fields, making it much easier to understand and
maintain.

O Select a Database file from file

@ Click OK to close the dialog box and return to your Design.
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Adding a Database Field to the Design
To insert a merge field into your design:

© Place your cursor in a Text Frame at the exact location for the Merge
Field to be placed.

@ Ifyou have closed the Insert Merge dialog, choose Insert Merge

Field... from the Utilities menu, or click the Field button on the
Design Job Toolbar to open the Insert Field dialog box.

Inzert Merge Field

Firzt Mame

tiddle |

Last Name

Company Marne

Title

Addreszz One

Address Two LI

Merge File...l Inzert I Cloge I Help |

® Choose the Field Name for the field you want to merge, from the
scroll list.

® Click Insert to place the Field on your Design.



The Field appears as a code, with the Field Name enclosed in
brackets.

{Company Name}

Alin {Firg Mame} {Campany Bar
{Aderam Cina)
{Citgl, {tatel {2ip Codal

Here, we are creating an address label, and have placed the Company
Name field from a MicroVision Address Database.

To insert additional fields:

® Move the cursor to the position where the next field is to be
inserted.

@ Double click on the field to insert in the Insert Merge Field dialog
box, or select the field and click the Insert button.

The new field is inserted
@ Repeat steps 6 and 7 to insert as many fields as necessary.

O Click on the Close button of the Insert Merge Field dialog box when
all the fields have been inserted.
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We added the First Name, Last Name, Address One, City, State, and
Zip Code fields to complete the label.

Remember to place spaces between fields, just as with other words, because SureThing places
the fields exactly where you specify with relationship to the rest of the document. For example,
if you want to merge the First Name and Last Name fields from a database file, you should
insert the First Name field, press Spacebar, and insert the Last Name field. If your document
shows Dear{FNAMEH{LNAME} with no spaces, it will print as DearJohnGalt when it is merged. If
your document shows Dear {FNAME} {LNAME} it will print correctly as Dear John Galt.

You can format inserted merge fields as if they were regular words.
Simply double-click a merge field to highlight it, then change font, size,
etc. as you normally would. All of the formatting control that applies to
regular text also applies to merge fields.

PRINTING A DESIGN WITH MERGED DATA

Printing a Design that has information merged from a Database requires a
couple of special steps. You have to tell SureThing which Records of the
Database to include, and which of you current Designs to merge with the
Data.
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To print a Design that has Fields merged from a Database file:

© Choose Print from the File menu, press Ctrl+P, or click the Print
button on the Control Strip to open the Print dialog box.

Print
Frinter: I Default:Panazonic kKx-P4420 an LPT1: ;I
ﬁin:IUppel tray Ll I Sample ]
Prirt {1 ) Sets
Cancel |
Options...
Settings  Merge I Sides | ﬂl
Recaords ﬂl
" Maone
(o E
" Range
|1 To:|2 Mo, of Sheets Required 1
Set Merge File

W TestforOverflow [ PrinttoFile [ Backaound [ Crop Marks

@ Choose the Merge tab.
® Click the Printer dropdown list, and select the correct printer.

O Click the up arrow in the Print quantity box to select the number of
Sets of Designs you want to print.

A Set includes one Design printout for each specified Database
Record.

@ Choose All on the Merge tab to print a copy of the Design with each
Record in the selected Database.

or:

@ Choose None to print the Design without any data, and with the
Fields expressed as codes, just as you see them on the screen.
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or:

® Choose Range to print copies of the Design with data from a
contiguous group of Records.

Choosing Range requires you to know the order of the records in
your database and which ones you want to print. Refer to Chapter
10 for a information about sorting and moving around in a database.

@ If'you selected Range as the group of Records, enter the record
numbers of the first and last records to be merged.

Note that as you specify the number of Records, and the number of
Designs to be printed, SureThing calculates the number of
preprinted pages that you need to complete the merge, and lists the
information below the Sample area of the Print dialog box.

@ Click Test for Overtlow for SureThing to automatically calculate
whether the text and data you have specified fits within the
boundaries of the Page you are printing on.

O Click OK to start the Print job.

Betore you start printing, be certain you have put paper in the
printer. We recommend printing a test set of merged Designs on plain,
cheap paper before you print on your special stock.

OTHER FIELD TYPES

SureThing also allows you to insert other fields which contain
automatically generated data. You can insert Auto-Numbers, to
automatically number paragraphs, dates and times which display either
the moment they were inserted or are updated when you print, the
filename of the current document, user information (as used by
SmartDesigns), and sequence numbers. To insert other types of tields,
use the Insert Field command from the Utilities menu.
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Sequence Numbers

Sequence Numbers are used to automatically create a series of numbers
on successive designs. This is useful for serial numbers, diskette sets,
tickets and other similar applications. To add sequence numbers to your
design:

O Choose Insert Field trom the Utilities menu to bring up the Insert
Field dialog.

Insert Field
Field Type: Data;

User Information
terge Field
Frint D ate

Frint Time
iSequence Mumber

§ettings...| ok I Egncell Help... |

@ Scroll the list of field types down to select Sequence Number.
® Press the Settings dialog to set the Sequence properties.

O Set the properties using the Sequence Number dialog.
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The Sequence Number Properties Dialog

Use the Sequence Number dialog box to control the sequencing of the
inserted number.

Sequence Field [ x|

Initial W alue: I oK |
Ihcrement: |1 Cancel |
M anirun W alue: IBDDDD Help... |

W Beset after printing

Initial Value determines the starting number to be used when printing
designs. The number can range from 0 to 32000.

Increment determines the amount added to the sequence number when
preparing the next item to print.

Maximum Value determines at what point the incremented number wraps
back to the initial value.

Reset After Printing specifies whether the number should continue
growing. If this is checked, each time a new print job is started, the
Initial Value will be used. If it is unchecked, the field's value is saved with
the document so that each time a print job is started, it uses the last used
value plus the increment.

Serial numbers on a parking permit is a good example of using
Sequence Numbers with the Reset After Printing box left unchecked, so
that each permit has a unique number. Number a set of three disks is a
good example of checking the box, so that a new set is created each time
you print.

R n . Remember that Sequence Numbers are inserted right into a text frame. Therefore, if you want
s toprefix or postfix text to your sequence number, just type it before or after the inserted field.
An example: Permit B-001-000-5, where the sequence number is the 5.
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When your Design is complete, you are ready to print.

Remember that if your Design is intended for a preprinted paper
product, you have to load the appropriate paper in your printer prior to
printing.

However, you may want to print the Design on blank paper first, so
you can check details of the Design before printing on limited quantity

paper.

SETTING UP THE PRINTER

Don’t wait until your deadline is upon you to think about printing your
Design. Allow time to test-print the Design on blank paper at least once;
you’ll want to be sure you’ve created the perfect Design before you use
your special paper. You should also double-check the Printer Setup, and
Calibrate your printer before you print on custom stock.

To confirm the printer you want to use:

© Choose Printer Setup... from the File Menu.

The Printer Setup window appears:

Printer Setup

Printer

[currently Panazonic Kx-P4420 on LPT1:]
" Specific Printer:
| Panasanic Kx-P4420 on LPT1: =

Dgtions...l Cancel | Help... |

@ Choose the Detault or a Specific Printer:

SureThing assumes you are using the Default Printer, specified in the
Windows Control Panel, and used as the default by all windows
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programs. If you want to use a different printer, choose the Specific
Printer option. Click the arrow button to select a printer.

® Click the Options... button to set printer options such as paper size,
paper orientation, and printer fonts

® Click OK to confirm the Printer Selection and Setup

CALIBRATING THE PRINTER

Because each printer is full of working parts, the precision in each is
slightly different. Sometimes this may cause SureThing to slightly miss
the mark when printing on specialty papers. If this happens to you, you
need to calibrate your printer.

To calibrate the printer

@ Choose Calibrate Printer... from the File Menu

The Calibrate Printer dialog box appears:

Calibrate Printer [ x|
Frinter:
Paper Bir: [ Expand/Shirink I
ol -Q K
I Upper trap 'I _
Rl Tge—————— Hornizontal: ID E Cancel |
EE = = '|
[Offset— | Hel
Help...
[ Use with &l bins Harizontsk |” El
Wertical: ID El

Frint Calibration 5hest |

® Confirm that the correct printer is listed in the Printer field
© Press the Print Calibration Sheet button

® Fold the Calibration Sheet according to the printed instructions and
enter the values in the Offset fields.
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You printer will now be offset by these values to accommodate for
any errors in precision.

Printer Creep

Another error not uncommon in laser printers is a slight creep between
the top and bottom of the paper. This causes SureThing to think it is
printing at a certain position, when in reality it is not. This only has any
real affect on very small labels on some printers.

Unfortunately, because of the nature of this problem we cannot
measure this by the markings on the calibration sheets, so it must be done
by trial and error. Instead, insert a piece of the label stock that you are
currently working with. Then print a calibration sheet.

SureThing prints an outline of where it thinks the perforations line
up on the stock. If the lines at the bottom or right edge does not match
up with the perforations, you need to add or subtract an amount to the
Printer Creep fields.

If the line prints below or to the right of the perforation, you want to
make the value smaller (negatives are okay). If the line prints above or to
the left of the perforation, you want to make the value larger. We
recommend you start with one (positive or negative), and work from
there.

PRINTING

SureThing allows you complete control when printing your Design Jobs.
Much will depend upon whether you are printing a single design, a
Design Set, or a merged design, but they all follow the same basics and
then build up from there.

Printing a Single Design

© Put the correct paper in the paper tray of your printer

Use plain paper if you are doing a test-print; use your preprinted
paper or labels if you are printing final output.

® Choose Print from the File menu or the Print Icon on the Design
Job Toolbar.
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The Print window appears, so you can confirm the printer setup and
set the print options:

Print
Frinter: I Default:Panasonic Kx-P4420 on LPTT: LI
Ein:lDefauIt:Upper tray LI I Sample ]
F"tl E * Copi
rint | E opies Cancel |
" Pages
. Options...
Sgttlngsl Merge | Sides I M
Designz il
= Al
£ Curert
! Hanae
|1 i I‘I Mo. of Sheetz Required 1

W Testfor Overflow [ Frint to File [T Backgound [ Crop Marks

® Make sure that the correct printer is selected, and that the printer is
setup correctly (the printer setup will default to the same setup as the
printer setup in your Windows Control Panel).

You can specify the number of designs to print either by the actual
number needed or by the number of total pages desired.

® Type the number of copies you want to print in the Print field.
Select whether you want the number to specify copies or pages.

Whether you choose copies or pages, SureThing tells you how many
sheets of paper stock you will need below the sample window. The
sample window is also used to specify where to start printing for the

first page.



@ Click on the first design in the sample window on which to begin
printing.

This will automatically recalculate the amount of stock you will
require. You will usually only start on something other than the first
design when you are trying to avoid wasting labels from partially us

Label manufacturers do not recommend running labels through your printer once you have
peeled off any labels, to avoid damaging your printer. While this is a common practice, it is
something you should consider before doing so yourself.

@ If'you are not going to feed paper into the printer in the default paper
tray, you can specify which bin from which the paper should come.
This is useful if you have more than one bin or want to force the
printer to use the manual feed for your printer (if available).

@ Click OK to Print

Printing Design Sets

Design Sets follow the same basic rules as Single Designs with the
following additions:

» Choose All to print all of the Designs

» Choose Current to print the current Design

» Choose Range and identify the beginning and ending Designs to be
printed if you want to print more than one, but not all of the
Designs, or to print one design which is not the current Design.

Printing Merge Jobs

If you have a merge file attached to the Design Job, you can control
which records will print. Otherwise, Merge Jobs follow the same basic
rules as Single Designs and Design Sets with the following exceptions:

» The Merge Option is available to select a range of records from the
database in which to print.
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» Choose None to print the current Design as you see it on the screen
without merging.

» Choose All to print all of the records in the database.

» Choose Range and identify the beginning and ending records from
the database in which to print.

»  Unless you have chosen None, the number of copies represents the
number of sets to print. If you select two, you will get two copies of
each design for each record in the database.
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Once you have your basic Design created, you may want to add some
polishing touches of your own. While our SmartDesigns produce a
beautifully formatted Design that doesn’t demand additional formatting,
SureThing makes it simple to add your own ideas for elegantly formatted
text.

SELECTING TEXT

There are many times when you will want to make changes to blocks of
text with a single action. For example, you might want to delete a word,
or make a heading bold. To make these types of changes, you must first
select the text you want to change.

You will recognize a selected block of text immediately when you
see it on the screen. Instead of seeing the blinking text cursor, you will
see a block of text displayed in reverse video. That is, the characters will
be drawn in white with a black background.

You can select text either with the keyboard or with the mouse.
Either way, you are telling SureThing where the start of the selection
begins and where it ends.

Selecting Text with the Keyboard

To select text with the keyboard, you use the left, right, up, and down
arrow keys while holding down the Shift key at the same time. If you
want to select the next word, for example, press and hold down the Shift
key, and press the right arrow key until the whole word appears selected.

Selecting text with the keyboard is not limited to the arrow keys.
Any key that moves the cursor from one location to another, such as the
Page Up and Page Down keys, can also be used to select text. Just
remember to hold down the Shift key at the same time.

Selecting Text with the Mouse

Selecting text with the mouse is often easier and faster, especially when
you are selecting a lot of text. Like everything with the mouse, it takes a
little time to become coordinated with its use, but once you do you’ll
find it is worth the effort.
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To select text with the mouse, click into the document at the
position you want to begin the selection. When you click, do not release
the mouse button, but keep it pressed down.

Now with the left mouse button down, simply move the mouse to
the end of the selection. You can move it left, right, up or down.
Characters, lines and paragraphs are selected accordingly. If the end of the
selection is not visible on the screen, simply move the mouse to the top
or bottom of the screen and the document will automatically scroll.

There are two other handy methods for selecting text with the
mouse. First, if you double click anywhere in the text, it will select the
whole word where you double clicked. Second, if you move the mouse
to the left of any line of text, the mouse will turn into an arrow. Clicking
selects the entire line. Dragging up or down selects lines above and
below.

FORMATTING TEXT

In SureThing there are several ways to format and edit text, so you use
the method that suits you best:

There are formatting buttons on the Control Strip, there are
formatting options on the Format menu, and there are keyboard
shortcuts for several formatting operations.

» Ifyou are changing a single common formatting option, such as
making text bold, or centering a paragraph, try a keyboard shortcut,

or a Control Strip button.

» Ifyou are changing several formatting options at once, choose
Character... or Paragraph... from the format menu.

You can format text before you type it, or after.

» To set the formatting options for the text about to be entered, follow
the steps in each section below to turn on the formatting options.

» To format existing text, select the text, then follow the steps below
to turn on the formatting options.
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Formatting options come in two flavors: Character Attributes and
Paragraph Attributes:

»  Character Attributes are variations determining the appearance of the
text itself. Character Attributes include: typeface, type point size,
type case, bold, italic, underline, superscript or subscript. Character
Attributes can be used singly, or in almost any combination— your
text can be bold, italicized, superscript, and small caps at the same
time.

»  Paragraph Attributes are design elements applying to an entire
paragraph, rather than to words or characters. Paragraph Attributes
include: paragraph indent, paragraph alignment, line spacing, tab
settings, borders and shading, and bullets with a hanging indent.

Formatting Text with the Control Strip

The Control Strip, which sits just above the horizontal ruler at the top of
the main window, provides access to the most commonly used text
formatting commands. By using the Control Strip, you can immediately
start enhancing the look of your document.

ITimesNewHomarﬂlQ ﬂ B|I|U||g vIIEFvl

To use the Control Strip, first select some text as described in the
previous section. Then, using the mouse, click the button with the bold
face B. The B stands for Bold, and that is just what will happen to the text
when you press it.

From left to right on the Control Strip, use a similar technique to
apply the following:

Font Select from a list of available fonts. All TrueType and Printer fonts
available within Windows are shown in this list.

Point Size Select from a list of point sizes for the selected font. If the font
is scaleable (e.g., TrueType and PostScript fonts), the list is there for
convenience only, but you can enter any value from 1 to 999.
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Text Style The first group of buttons contains text style commands. From
left to right they apply Bold, Italics, Underline, or any combination of the
three.

Text Alignment The next drop-down list applies basic horizontal paragraph
alignment. You can have paragraphs aligned to the left or right paragraph
indents, centered between them, or justified.

Frame Alignment The last drop-down list applies basic vertical frame
alignment. You can have text aligned to the top or or bottom of the
frame, centered within the frame, or justitied.

These are just the basics, of course, however common they appear.
Be sure to check out the Character and Paragraph dialog boxes from the
Format menu for more formatting options.

Formatting Text with the Character Dialog Box

Use the Character command under the Format menu to change the
character formatting attributes of selected text, or to set the attributes for
new text you type. Character formatting attributes consist of typeface
selection (font and font variations such as bold, italic, etc.), font size in
points, underlining options, and position and spacing options
(superscript, subscript, spacing, and pitch). Choosing the Character
command opens the Character dialog box, which is divided into two
tabs: Font/Style and Position/Spacing.



Character > Font/Size Dialog Box

Character
Font/Style I Position/Spacing I
[ Underline
[~ Continuous & Single
Poirt Size:  Calor; [ wiord " Double
|12 LI Ii Black LI ;
" Capitals
Style [~ &l Caps
™ ltalic [~ Bold [~ Strike Out [ Small Caps: I x
Sample
AaPhCe =Ty
Diefault | Cancel | Help... |

The Sample area of the Character dialog box displays a sample of the
currently selected formatting options, letting you see the effect of your
formatting choices before applying them.

Font Choose from a menu of fonts installed in your system.

Point Size You can either select a point size from this menu, or type in any
size between 1 and 999. Sizes must be whole numbers, however. You
can not enter half sizes such as 72.5.

The unit of measurement for fonts is points. The higher the number,
the larger the font. There are 72 points in an inch, so a 36 point font, for
example, would be approximately one-half inch in height—
approximately because font designs vary, and a font at one size may be
somewhat larger or smaller than a difterent font at the same point size.

Color Choose from a menu of colors you can apply to text. These are the
same colors you can choose for border lines, shades, and graphic objects.
The last item in this menu is Define Colors. Choose this option to open
a dialog box where you can specify a color and assign it a name. The new
color will then appear in the color menu.
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style Check an option, or any combination of options, for the available
type styles: bold, italic, and strikeout.

Underline There are two different types of underlining attributes:
continuous underline and word underline. Continuous underline (which
is the underlining option you can choose from the control strip)
underlines text, spaces, and tabs. Word underline does not underline
spaces or tabs. For either underlining option, you can specify whether
you want the underline to be a single or double line.

You can select one type of underlining or the other—or none—but
not both.

Capitals Choose the All Caps attribute to display text in all uppercase
letters. This command is different from pressing the Shitt or Caps Lock
keys on your keyboard because, like all other attributes, All Caps can be
turned off, returning text to lowercase (if it was typed without using the
Shift or Caps Lock keys). To better illustrate this, type some lowercase
text. Then press the Caps Lock key and type some uppercase text. Select
all the text, choose the Character command from the Format menu, and
click the All Caps option. Both sets of text you typed appear as uppercase
letters. Now, with all the text still selected, turn the All Caps option oft.
Notice that text you typed with the Caps Lock key depressed is still
uppercase, but the text you had changed to uppercase with the All Caps
option is now lowercase.

The Small Caps attribute displays lowercase text text in uppercase
letters, but at a reduced percentage of their actual size. If your text size is
10 points, for example, and you create small caps set to 80%0, all lower
case characters will appear as all caps set to 8 points. Uppercase text is not
aftected by this command.

Default Click Default to return all formatting options to the default state.

Apply Click Apply to close the dialog box and apply any formatting
options you may have selected.

Cancel Click Cancel to close the dialog box without applying any changes
to character formatting.



Character > Position/Spacing Dialog Box

Character
FontdStyle FPuosition/S pacing I
Super/Subscript Spacing
Fosition:| 20 % Amourt 100 %
[~ Subscript Size:|on % Pitch: {1000 || %
Sample
A aBhCo¥yZz

Diefault | Cancel | Help... |

Super/Subscript Choose Superscript to move text above the baseline (an
imaginary line where characters rest); choose Subscript to move text
below the baseline. If neither option is selected, text is positioned on the
baseline. The Position value determines how much, relative to the
normal text height, text should be moved up or down—20% is the
default. The Size value lets you specity whether superscripted or
subscripted text should be reduced in size. The default value of 80%
means that text will be reduced to 80% of its original size, e.g., if the
point size is 10 points, superscripted or subscript text will appear as 8
point text.

To return text to its normal position on the baseline, select it and
un-check the Superscript or Subscript options.

Spacing In addition to adding space between letters and words by pressing
the spacebar, SureThing lets you adjust spacing in fractional amounts.
Each character in a font (including the spacebar character) is surrounded
by a certain amount of space. Otherwise, letters would all run into one
another and legibility would be very poor. You can expand or condense
this space by entering a value in the Amount box. 100% is the default,
and is the equivalent of no extra spacing at all. Values less than 1009 will
decrease, or condense, the amount of space between letters and words;
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values greater than 100% will increase, or expand, letter and word
spacing.

SureThing also lets you alter the width of the characters themselves
(as opposed to just the space between them) by entering values in the
Pitch field. Values greater than 100% increase the width of individual
characters, stretching their outlines horizontally; values less than 100%
decrease the width; compressing character outlines horizontally.

Default Click Default to return all formatting options to the default state.

Apply Click Apply to close the dialog box and apply any formatting
options you may have selected.

Cancel Click Cancel to close the dialog box without applying any changes
to character formatting.

Formatting Text with the Paragraph Dialog Box

Use the Paragraph command on the Format menu to change the paragraph
formatting attributes of selected text, or set the attributes for the
paragraph containing the cursor. Paragraph formatting attributes are
applied to entire paragraphs, rather than single characters or words.
Alignment, indents, line spacing, tab placement, etc., are examples of’
paragraph formatting attributes. Choosing the Paragraph command opens
the Paragraph dialog box, which is divided into two tabs: Spacing and
Tabs.

Paragraph > Spacing Dialog Box

The Spacing tab provides options for changing the line width of your
paragraphs via left and right indents, options for changing the line
spacing, or leading, of paragraphs, and a menu for selecting how you want
your text to be aligned.
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Spacingl Tabs I
Indent Spacing
Lett: W Before: |0 pt
Right: | 0.00 in After: | 0 pt
Firgt: | 0.00 in Leading: [100 | %
Alighment:
Left LI Paragraph Character... |

Bulst. | Shadss |

Border... | Apply I Cancel | Help... |

Indent Enter values in these boxes to control the amount of space
between a paragraph and the left or right margin. By default, paragraph
indents are lined up on the margins, i.e., set to 0.00 inches.

There is a key difference between margins and indents: margins
control remain the same for each frame in the design; indents control the
width of paragraphs and can change from paragraph to paragraph. In other
words, margins are a frame formatting attribute, while indents are a
paragraph formatting attribute.

Alignment Choose options from this menu to apply left or right alignment
to a paragraph, or to center or justify it.

Left-aligned paragraphs have an even left edge, and an uneven, or
ragged, right edge. Left-alignment is the default for new paragraphs.
Right-aligned paragraphs are even with the right paragraph indent, but
have a ragged left edge. Center-aligned paragraphs are centered between
the left and right indents (not between the left and right sides of the page,
nor between the left and right margins). Justified paragraphs have both an
even left and right edge. For justified paragraphs, SureThing adjusts the
amount of space between words so that each line of the paragraph is even
with both the left and right paragraph indents.

Since alignment is the most commonly changed paragraph
formatting attribute, a dropdown list box also appear on the control strip.
You can also change paragraph alignment options by using keyboard
shortcuts:
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To: Press:

Left align Ctrl+Shift+L
Right align Ctrl+Shift+R
Center Ctrl+Shift+C
Justify Ctrl+Shift+)

Paragraph Spacing Line spacing is the vertical distance between lines of text
in a paragraph, and is controlled by two factors: the size of the font, and
the Line Space value, also known as leading, specified for the paragraph.
A line spacing value of 100% means no additional spacing beyond that
built into the font itself (and individual fonts may vary considerably).
Entering a larger value increases the space between lines. You may find a
leading value of 100%, for example, to be the optimal leading for many
text fonts. Using this as your guideline, a value of 150% would be the
equivalent of one and one half lines of spacing; 200% would be
approximately equal to double line spacing, etc., etc.

You can also add spacing, in inches, centimeters, or points, between
paragraphs (the default is points). To add extra space between paragraphs,
enter values for the amount of space you want above, below, or both
above and below the current paragraph or selected paragraphs in the
Before and After boxes. These values do not affect the amount of space
between lines within a paragraph, just before and after it.

The default is zero points. If you want to enter a value in inches, type
in after the value; type cm if you want to enter the value in centimeters,
or pi to enter it in picas. Typing nothing—or pt—after a value tells
SureThing to use points. SureThing using the following equivalents:
One inch = 72 points = 2.54 centimeters = 6 picas. One centimeter = 28
points = 0.39 inches. You don’t have to enter a space between the value
and the unit, e.g., typing either “12pt” or “12 pt” is acceptable, but
“12p” would result in an error.

N " Use the Before and After spacing options to add space between paragraphs rather than adding
s blank lines after each paragraph. For example, enter a value of 12 points in the After field for
the equivalent of a blank line.

Paragraph Character Click this button to open the Character dialog box
where you can choose character formatting attributes, or select a character
style, to be applied to the current paragraph. (See the Character
command section in this chapter for more information.)
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Bullet Click Bullet to open the Bullet dialog box where you can create
different types of bulleted paragraphs.

Shades Click Shades to open the Shades dialog box where you can select
difterent shades, patterns, and colors to apply as backgrounds for

paragraphs.

Border Click Border to open the Paragraph Border dialog box where you
can control the placement and style of paragraph border lines.

Apply Click Apply to close the dialog box and apply any formatting
options you have selected.

Cancel Click Cancel to close the dialog box without applying any changes
to selected text.

Paragraph > Tabs Dialog Box
The Tabs tab in the Paragraph dialog box is the same as the Tabs dialog

box that appears when you choose the Tabs command. There is no
difference between setting tabs using either dialog box. The benefit to
setting tabs from the Paragraph dialog box is that you can define them
along with other paragraph formatting attributes and save them as part of
a defined style.

Paragraph [ X]
Spacing Tabs I
Set Tabs At Clear Tabs At Leader— 7 [ Alignment |
050 * Maone * Left
" Solid " Right
= Dashed-—- " Center
" Datted......  Decimal
Default Width:
Set | Clear | Delete | CIea[AIIl Iu.5g in

Bulst. | Shadss |

Border... | Apply I Cancel | Help... |
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SetTabs At Lists the position and alignment of each tab on the ruler,
starting from the left, for the selected paragraph. A tab’s position is
measured in inches from the left margin (not the left edge of the frame).
If you change your margins, all tab stops are adjusted automatically.
When you open this dialog box, the first tab is highlighted. Click any tab
from this list to begin editing it (changing its position, alignment, leader,
etc.), or if you want to add a new tab, enter its position in inches from the
left margin and click the Set button.

Clear Tabs At T'o remove tabs, first highlight the tab to be removed in the
Set Tabs At list, then click the Clear button. The tab is placed in the
Clear Tabs At list. If you change your mind, you can select a tab from this
list and click the Set button to place it back in the Set Tabs At list. You
can remove all tabs by clicking the Clear All button.

Leader SureThing lets you apply various styles of leaders to any tab. A
leader is a repeated pattern, such as a series of dots or dashes, between the
tab and the preceding text. To apply a leader, first select the tab from the
Set Tabs At list, choose the type of leader you want to precede the tab,
then click the Set button. To remove a leader from a selected tab, click
the None option, then click Set.

Alignment There are four types of alighment you can apply to a tab: left,
right, centered, and decimal. Tab alignment determines how text is typed
at a tab. By default, tabs are left-aligned. To apply a different alignment,
first select a tab from the Set Tabs At list, choose a difterent type of
alignment, then click the Set button.

Default Width Even if no tabs have been created, left-aligned default tab
stops appear at certain intervals for all paragraphs. Use this option to
determine the interval. The initial setting is one-half inch.

Delete Click the Delete button to remove the selected tab from either the
Set Tabs or Clear Tabs list. This button does not affect existing tabs on
the ruler bar; it simply deletes tab entries from the two lists. To remove a
tab, you must select and press Clear.



Default Click Default to return all formatting options to the default state
as determined by the current style (see the “Formatting with styles”
section for more information about creating and editing styles).

Define Click Define to display options for defining paragraph styles.
Defined paragraph styles appear in the Style Name list.

Bullet Click Bullet to open the Bullet dialog box where you can create
difterent types of bulleted paragraphs.

Shades Click Shades to open the Shades dialog box where you can select
different shades, patterns, and colors to apply as backgrounds for

paragraphs.

Border Click Border to open the Paragraph Border dialog box where you
can control the placement and style of paragraph border lines.

Apply Click Apply to close the dialog box and update the ruler with the
changes you made.

Cancel Click Cancel to close the dialog box without applying any changes
to selected text.
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chapter 8 | Customizing Your Design

Although our SmartDesigns try to anticipate your needs, there may come
a time when you wish to customize your design in a way which was not
anticipated. For example, you many need to add additional text or
graphics to your design.

SureThing provides you with a full set of design tools which you can
use to customize your design. You can even start with a completely
blank page and create your design from scratch.

» You can draw basic graphic shapes in your design— Straight Lines,
Rectangles and Squares, Rounded-corner Rectangles, Ellipses, and
Circles.

»  You can add graphics created by other programs— Import Windows
Bitmap (BMP), Tagged Image File Format (TIF), PC Paintbrush
(PCX), Windows Metafile (WMF), Encapsulated PostScript (EPS)
and other graphics files.

»  You can add blocks of your own text to your design by creating Text
Frames.

»  You can create special text frames which allow you to apply special
effects to the text such as filled patterns, shading, shadows, and
curved text. We call these Text Effects.

USING THE TOOLS

SureThing provides easy-to-use tools for creating Text, Lines, Shapes,
Pictures, and Text Eftects. There are two ways to select a tool for adding
these objects to your Design:

O Sclecta Tool from the Control Strip.

El| e[ e[| «[o]|o]o]

= Choose the Text Frame Tool to add text to your Design.
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or:

ol | |

lo

=] Choose the Picture Tool to add a graphic from another program

to your Design.

] Choose the Text Effect Tool to apply special effects to text.
o Choose the OLE Tool to draw a OLE object. This allows you

to import images from other applications such as a spreadsheet
from Excel.

Choose the Line Tool to draw a straight line.
Choose the Rectangle Tool to draw a rectangle or square.

Choose the Rounded Rectangle Tool to draw a rectangle or
square with rounded corners.

Choose the Ellipse Tool to draw an ellipse or circle.

Choose Tools from the Object menu, and select a Tool from the
pull-aside list:

Lire Taal
Rectangle Toal
Rounded Rect Taol
Ellipze Tool

Text

Picture

Test Effect

OLE Opject

When you select a drawing tool, the cursor changes to a crosshair

containing a representation of the object you are about to create. If you
are drawing an ellipse, for example, the cursor is a crosshair with an
ellipse below and to the right of it.

While the procedure for creating an Object varies somewhat with

each type of Object, the following basic steps apply to all Objects created
with the Tools:

O Position the crosshair where you want one corner or end of the

object.
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@ Click and hold the left mouse button while dragging the cursor to
the other end or far corner of the object.

The bounding box of the object you are drawing “rubberbands” as
you move the mouse, showing the changing size and extent of the
Object.

® Release the mouse button when the Object is the correct size and
shape.

In SureThing, you do not have to draw the Object flawlessly the first
time. You can easily adjust the size and position of any Object anytime, as
well as set a variety of visual properties for the Object.

Follow the detailed steps outlined in the following sections to place
new text, lines, shapes, and pictures in your Design.

ADDING TEXT

Text that you add to your Design is placed inside a Text Frame. A Text
Frame is an invisible box containing text you type. Text Frames act as
Objects, and can be moved, resized, manipulated, and have attributes
assigned like any graphic or shape Object. Text inside a Text Frame can
be edited and formatted as any other text.

To add a Text Frame to your Design:

© Choose the Text Frame Tool =l from the Control Strip or from the
Tools list on the Object menu.

The cursor changes to a crosshair + text icon.

@ DPosition the crosshair on the Design where you want one corner of
the Text Frame.

® Click and hold the mouse button while dragging the cursor to the far
corner of the Text Frame.

O Release the mouse button.
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(5]

Type the text.

The text automatically wraps to new lines as necessary to fit within

the Text Frame.

By default, text can only flow within a frame until it reaches the bottom. At that point, it is
considered to have overflowed. When this happens, SureThing draws a red bar along the
bottom of the frame (which will also print) to alert you that this condition has occurred. You
will then need to increase the size of the frame, delete some of the text, or reduce the point
size of the text.

DRAWING A LINE
To add a straight Line to your Design:

(1]

(4]

Choose the Line Tool = trom the Control Strip or from the Tools
list on the Object menu.

The cursor changes to a crosshair + line icon.

Position the crosshair on the Design where you want one end of the
Line.

Click and hold the mouse button while dragging the cursor to the far
end of the Line.

Release the mouse button.

The Line appears on your Design.

Drawing a Horizontal or Vertical Line

To constrain the Line to Horizontal, Vertical, or a 45° angle, hold down
the Shift key while dragging the line.



DRAWING RECTANGLES AND ELLIPSES
To add a Rectangle or Rounded Rectangle to your Design:

(1]

Choose the Rectangle Tool g, the Rounded Rectangle Tool g,

or the Ellipse Tool el from the Control Strip or from the Tools list
on the Object menu.

Position the crosshair on the Design where you want one corner of
the Rectangle or Ellipse.

Click and hold the mouse button while dragging the cursor to the far
corner of the Rectangle or Ellipse.

Release the mouse button.

The Rectangle or Ellipse appears on your Design.

Drawing a Perfect Square or Circle

To constrain the Rectangle or Ellipse to a perfect square or circle, hold
down the Shift key while dragging the Rectangle or Ellipse.

ADDING A PICTURE OR GRAPHIC

You can incorporate pictures from a variety of programs, and in a variety
of formats into your design. This is a good way to place a company logo,
or a photo.

To add a picture to your Design:

(1]

Click the Picture Tool =] on the Control Strip.
The cursor changes to display the Picture icon.

Click the cursor in the Design Area where you want to place your
graphic.
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Or, if you know the approximate size and shape that you want for your
picture:

® Use the Picture cursor to drag out the bounding rectangle for your

graphic.

Whether you click a position, or drag a bounding rectangle, the New
Picture dialog box appears when you have completed the cursor
action in the Design Area.

New Picture H
Lookjn | Wwindt =l k| fe Previont

Syztem @Eastle.bmp @Marhle. brap @Winlogo.bl

28Ecolor.brp @Chitz.bmp @Hedbrick. brap @Zigzag. brii

Arcade.bmp @Egypt. brp @Hivets.bmp

Arches.bmp @Flock. brp @Squares.bmp

Argyle.bmp @Honey. brnp @Tartan. brnp

Cars.brp @Leaves.bmp @Thatch.bmp

L

| _,I Preview |

File name:

Filez of type: I.QII Fictures j Cancel ™ Merge:

[~ Ahwaps Preview
V¥ Save with Document

aK

Help |

® Specity the type of graphic you are importing in the List Files of

o

Type: field.

Type the exact name of your picture file in the File name: text entry
field, or select the filename from the Filename: scroll list.

To view a small (“Thumbnail”’) representation of the selected
picture, Click Preview The Thumbnail picture appears in the
Preview area of the New Picture dialog box.

You can also set SureThing to automatically display the preview for
the selected picture, so you do not have to choose the Preview
option each time the New Picture dialog box is opened.



To turn on the automatic Preview option, click the Always Preview
Check Box. A check (O appears, indicating that the Always Preview
option has been turned on.

O Click OK.

The New Picture dialog box closes, and your picture appears in your
design.

TEXT EFFECTS

You can dramatically enhance your designs by creating Text Effect
objects. Text Eftects are special text frames to which special effects are
applied such as curves, shadows, filled colors and patterns. Text Eftects
can also be rotated to any arbitrary angle.

To add a Text Effect to your Design:

O Click the Text Eftect Tool ] on the Control Strip.
The cursor changes to display the crosshair + Text Eftect icon.

® Position the crosshair on the Design where you want one corner of
the Text Effect.

® Click and hold the mouse button while dragging the cursor to the far
corner of the Text Effect.

O Release the mouse button.

The Text Effect appears on your Design with the words Your Text
Here inserted by default. Don’t worry if this looks distorted, once you
add your own text and specify the effects you want, it will look great.

To edit the text and properties of Text Eftects, double click on the
Text Effect. This will bring up a dialog which allows you to completely
control the text and appearance. See Chapter 9 for more information on
editing a text effect.
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OLE OBJECTS

SureThing is an OLE 2.0 container, meaning it can import OLE objects
from OLE server applications such as Paintbrush, Word Pad, Microsoft

Excel, etal. Note that OLE Objects are not supported in the Windows

3.1 version.

To add an OLE object to your Design:

O Click the OLE Object Tool ]| on the Control Strip.

The cursor changes to display the crosshair + OLE Object Effect

icon.

@ DPosition the crosshair on the Design where you want one corner of
the OLE Object.

® Click and hold the mouse button while dragging the cursor to the far
corner of the OLE Object.

® Release the mouse button.
The Insert Object dialog box appears.

Inzernt Dbject [ 7]

O e
Cancel |
Help |

I Dizplay &z lcon

% Create New

CorelCHART! Chart
CorelD R Graphic
CorglPHOTO-PAINT! Picture
Equation

Internet Document [HT ML)
Media Clip

Microzaft Drawing ;I

" Create from File

Rezult
Inzerts a new Bitmap Image object inta your

document,
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@ Seclect the object type, or choose to create the object from an existing

file.
® Click OK

The OLE Object appears on your Design.

GROUPED OBJECTS

Objects created by SmartDesigns are often grouped so that they can be
moved as a unit. There may be times when this is inconvenient, and you
will want to ungroup them and manipulate them directly. The only side-
effect to ungrouping objects is that once they have been ungrouped, there
is no facility in SureThing for grouping them.

To ungroup objects created by SmartDesigns:

© Using the Pointer Tool, select any of the objects to select the entire
group.

@ Use the Ungroup command on the Object menu to ungroup them.
Immediately after you issue this command all of the objects will still
be selected, but each object can then be selected independently.

GROWING/SHRINKING TEXT FRAMES

Text frames can be set to grow and shrink, based on the text inside them.
This is useful to avoid text frame overflow. Most text frames created by
SmartDesigns have this ability set. This allows SmartDesigns to manage
the size and position of the text frame, and other objects that relate to it,
as the text, fonts, and point sizes change.

You can set the growth properties for a text frame in the text frame
properties dialog box. In the dialog, there is a tab for Growth. This
allows you to set the following properties for a text frame both
horizontally and vertically:

O You can set how text frame should grow. You can choose either
Fixed, Align Top/Left, Align Center, or Align Bottom/Right. Fixed
indicates that the frame does not grow.
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® You can set the minimum value to which the frame can shrink.
® You can set the maximum value to which the frame can grow.

Keep in mind that if a text frame is set to grow automatically, you
can not size it with the mouse. The size is instead determined by the text
inside the frame.

ROTATING OBJECTS

Text frames, pictures and text effects can be rotated. Text frames and
bitmap pictures can be rotated in 90 degree increments. Text effects and
Windows metafiles can be rotated at any arbitrary angle. SmartDesign
objects which are grouped together can not be rotated.

For rotatable objects, you can specity the degree to which they can be
rotated in the object's properly dialog box. Additionally, you can use the
rotation tool as described below.

Rotating Objects with the Rotation Tool

O Click the Rotate Tool on the Control Strip. The cursor changes to
show a almost complete circle with an arrow at one end..

@ Click on the object you wish to rotate to select it. If the selected
object can not be rotated (i.e. a square or a group), a small circle with
a line through it will appear in the mouse cursor.

® Once you have selected the object you wish to rotate, move the
mouse to over of the four corners of the object. When you see the
mouse cursor change to a small arc with arrows at both ends, you
have found the rotation spot.

® Click on the rotation spot and while holding the mouse down, move
it in a circular motion. You will see a rubberband rectangle spinning
around the center of the object as you move the mouse.

©® When you have reached the desired angle of rotation, release the
mouse.
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In addition to rotating objects with the rotation tool, you can do
many of the same things you can do with the pointer tool, including
selecting, moving, and double clicking on it to bring up the object
properties.

Things to consider when rotating objects

There are a couple of things you'll want to keep in mind that when
rotating objects. First, when you release the mouse with the rotate tool,
objects which can only be rotated by 90 degrees will snap to the nearest
90 degree increment (0, 90, 180, 270). This is indicated by a heavy black
rectangle as the object is rotating, but is sometimes hard to see.

Second, objects can not be rotated such that any part of the object is
off the design area. For example, take a short wide label which has a text
frame that occupies most of the design area. You can not rotate this text
frame by 90 degrees, since the text frame would then be tall and skinny,
extending off the label.

If you want to create a rotated object for such a label. You will first
need to size the object small enough in both dimensions so that it can be
rotated, and then resize it. In the example above, you could size the text
frame to be no wider than the height of the frame. Then rotate it.
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Chapter 9 | Text Effects

With SureThing you have the ability to create stunning eftects with text
to make your designs stand out. You can fill each character with
patterned colors, create shadows, wrap the text along curves, and rotate
the text to any angle. Once you’ve mastered the basics, your text can
come alive.

This chapter will show you how to edit the properties of a Text
Eftect. From entering your text, to giving it special qualities, you will use
the Text Effect Properties dialog box. To access this dialog, simply
double click on a text effect, or use the right mouse click and select
Object Properties from its menu.

USING THE TEXT EFFECT DIALOG

Regardless of how you access the Text Effect Dialog, the following
screen appears:

Text Effect E
Text: ak I Cancel | Help... |
csianE soress Fl. | Ouine. | Shadon |
Shades... | Border... | More... |
Preview |
S Effect: “Wariation:
O IPerspective Right ;I IPerspective LI
Eort: Shyle:
§U@m IMyliadHeavy Ll IHeguIar Ll
Alignment:
IEenter 'I

CHANGING THE TEXT COLOR AND APPEARANCE

You can add patterned fill color to your text, and create a drop shadow.
To apply these changes you will extensively be using the Shades and
Lines dialog boxes.
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»  Use the Fill button to specify a pattern and/or colors you wish to use
to fill the face of each character.

»  Use the Outline button to specify a line style and color to use to
draw the outline of each character.

»  Use the Shadow button to specify a shadow for the text and which
pattern and/or colors to use for the shadow.

CHANGING THE BACKGROUND COLOR

You can change the background color and give it a border. When you
apply effects to the text, the shape is not always rectangular. Instead, it
follows the path of the text. This can provide dramatic effects. Later, we
will show you how to frame the entire eftect within a rectangular area.

»  Use the Shades button to specify a background pattern and/or color
to use with the effect.

»  Use the Border button to specify a line style and color to use as the
border to use with the eftect.

SETTING THE EFFECT

Text Eftects have a number of shapes and curves to which you can fit
your text. You can curve your text around a circle, arch it up or down,
or simply fit it to a rectangle.

To apply an effect:

»  Use the Effect dropdown to select one of the predefined curves or
shapes for your text. Once you select, the Sample will immediately
show you what the eftect looks like.

»  Use the Variation dropdown to select a variation of the effect. Each
Effect will have its own set of variations, so you can experiment with
these to find the one which best fits your needs.
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CHANGING THE TEXT ATTRIBUTES

You can change the font, its style, and the alignment of the text. The size
of the text is controlled by the size of the Text Effect object itself, so
there is no setting for point size.

»  Use the Font dropdown to select a font to use for the text. Many
display typefaces work very well in Text Effects.

»  Use the Style dropdown to select the style for the font (i.e. Normal,
Bold, Italic). This list will include all true styles for the font as
reported by Windows.

»  Use the Alignment dropdown to select how the text is aligned in the
Text Effect. This only has meaning for some Eftects such as circles
and buttons, or when there is more than one line of text.

EDITING THE TEXT

You simply change the text in the Text field to your message. The text
can be any number of lines long, but as a general rule for most Effects, a
single line tends to work best. Rules, of course, have exceptions, so feel
free to try out your ideas.

A couple of things to keep in mind about the text:
» Buttons always have three lines. The first line wraps around the top
of the circle, the second line goes in the middle, and the third line

wraps around the bottom.

»  You can add spaces before and after your message to give it a little
different look in the Effect.

» Different words and combinations can change the look dramatically.
Experiment with your message to get the best results.
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MORE...

The More button allows you to fine tune the attributes of the frame
which surrounds the Text Effect. This allows you to control where it is
positioned, margins for the frame and the text within it, and background
lines and shades. T'wo items of particular note are contained within this

dialog:
»  You can specify an arbitrary angle by which the Effect will be rotated.

» You can change the angle and depth of a drop shadow.
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chapter 10 | Custom Label Sizes

Although SureThing comes equipped with SmartDesigns for the most
popular label formats, there may be occasions when you need a custom
label size. This can occur when you find label stock from a new vendor
which differs slightly from an existing SmartDesign or one that is
completely different.

In this chapter, we’ll modify an existing SmartDesign to
accommodate a slightly different page layout from a different vendor.
The concepts you learn, however, can be applied to create any custom

sized labels.

WHAT YOU NEED TO KNOW...

Before you begin creating a custom label, you will need to collect a bit of

information. This information describes how the labels are laid on on the

label sheet. Typically you will find this information supplied by the paper

vendor along with their products, but in some cases you might need to

use a ruler to measure. In all cases you will need to know:

»  The size of the paper. Most commonly this is letter sized (8.5"x11")
in North America, or A4 in rest of the world.

» The number of rows and columns of labels on the sheet.
» The width and height of the label itselt.

» The distance from the top left hand corner of the page to the top left
hand corner of the first label on the sheet (the Start Position).

» The amount of space between rows of labels and the amount of space
between columns of labels (the Gutter values). For many labels, there
will be no space between the rows and/or columns.

CREATING A CUSTOM SIZED TEMPLATE

You can create a custom sized label template which can then be reused
whenever it is needed. It will appear in the list of label types in the New
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Dialog right along with the SmartDesigns which are included with
SureThing. To begin, choose New from the File menu. The New
Design dialog box appears:

Hew

Smartgesignsl Databases |

Froduct Tepe: I [&ll Typesz) j Cancel
SmanDesigns CGample Help...
£ Envelopes = Search...
7 Index Products =
[E7 Labels - Inkjet
B Labels - Laser

7 [sorted by product]
B= Address
2160 Address B-up
2162 Address B-up
2163 Shipping 4-up
B 5160 Addn

Information...

Custom...
[ Blank Desians

N Show Backaround

) BEkE)

[Velete

Product Description/Compatibility:
1% 2548 in. Address label Aszorted Stocks, 30 |abels per sheet,

Avery: 5260, 5960
blaco; ML-3000, ML-30008, WL-3025, ML-4000, ML-8107, ML-S207, ML-8301, ML-8000
Z-Label 05160, 05260, 05960

When you start to customize a new label size template, you can begin

by:

» selecting an existing SmartDesign from the list and press Custom.
This is recommended if the new label is close in size to the existing
label and required if you wish to retain the SmartDesign Layouts.
or

» select the folder in the New dialog into which you would like to
place your new template and press Custom. This is recommended

when the new label does not closely match any exiting templates.

Either way, the following dialog appears:



Custom Page Setup - (none)

W [relude Smartesians from
5160 Address 30-up

[ Block Attributes [ Prexview
[ Size

Wit 2.625in

Labels || Height 1.000 in

Across IS_E

[ Start Pogition
D 10
oen [10} Lef 0188 in

Bleed [0.000In | TOP 0.500in

™ Circular [ Gutter
I Altemai Haorizantal (0,125 in
erhating

Wertical 0.000 in

g B4

Calibrate... Paper Size. .. | Mames Folders... |

]

Ok Cancel | Help |

Block Choose the block of labels you wish to modify. Typically there will
be only one block of labels on the sheet, so you will seldom need to
bother with this field. For example, many CD-ROM labels include a
round label for the CD and a rectangular label for the rectangular one is
for the jewel case. Note that you can not add or delete blocks, only
modify existing ones.

Labels Specity two values here, the number of labels across and the
number of labels down. This defines the number of rows and columns
on the sheet.

Size Specify the width and height of each individual label.

Start Position Specify the distance from the top of the label sheet to the first
label, and the distance from the left of the label sheet to the first label.

Gutter This is the distance between labels, if any. Specity the horizontal
distance between rows and the vertical between columns of labels.
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Bleed Specify the distance beyond the edge of each individual label on
which printing is allowed.

Setting a Bleed margin is useful if you wish to cover the entire area of the
label with a background pattern or image. To print beyond the edge of
the label compensates for mechanical errors in the printer as it rolls the
paper through during printing. Care should be taken, however, since this
can often cause printing to overlap into neighboring labels.

Circular Specifies that the shape of the label is round. Note that circular
labels must maintain an equal width and height.

Alternating This indicates that the labels zig zag down the page. This is
very uncommon and can generally be ignored and left unchecked.

Calibrate Printer Press this button to go to the Calibrate Printer dialog, you
can use this to print a calibration sheet to compare your label sheet with
the current template.

Paper Size Brings up the Custom Template Paper Size dialog as described
below.

Names/Folders Allows you to specify a name for the new custom label
template, and where to store it in the list of SmartDesigns using the
Templates Names/Folders dialog described below.

CUSTOM TEMPLATE PAPER SIZES

If your labels come on a difterent sized sheet of paper than the
SmartDesign you are starting from, you can change the paper size with
this dialog.



Template Paper Size
Paper Size Qrientation
£+ Portrait
width Height " Landzcape

|50 [11.00in

[~ 2sided  Mumber of Parts: I‘I E
Ok I Cancel | Help... |

Paper Size Select from a list of standard paper sizes supported by your
printer. A selection here will automatically fill in the width and height
fields. If the paper size is not included in the list, you can enter numbers
for the width and height manually.

Width Specify the width of the label sheet.
Height Specify the height of the label sheet.

Orientation Specify whether the label sheet should be printed in the
portrait or landscape orientation..

Two-Sided Specifies that you want to print on both sides of the design.
This is often useful for card stock products like business cards, index
cards, and postcards..

Number of Parts Specifies the number of parts to the page. This is almost
always one. It is most often used for label mini-sheets, where the page is
perforated and can be torn in half.
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TEMPLATE NAMES AND FOLDERS

Your custom templates can have names which will remind you of their
intended purpose, and be conveniently placed in one of the pre-existing
SmartDesign folders to help organize your materials.

All templates must have a name. You name your new template by
pressing the Names/Folders button in the Custom Paper Setup dialog. If
you click OK without giving it a name, the Names/Folders dialog will
automatically be presented.

Template Hames/Folders E

M arne:
I dy Cugtom Address

Degcription;

Description

W Place in folder;

3 Card Products -
£ CO-ROM

= Envelopes

7 Indes Products

£ Labels - Inkjet

= Labels - Laser

QK. I Cancel | Help |

Name Specify the name with which to refer to your new template. Make
the name meaningful so that its purpose is easily recognizable.

Description Specify a longer description of the template. You might also
want to include the name of the label sheet manufacturer along with their
phone number for ordering additional stock.

Placein Folder When this is checked, you can place the new template in any
of the existing SmartDesign folders. Pick one that most closely matches
the purpose of the new template. If you started your new template from
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scratch, this box will be dimmed and checked, since you must select a
folder in which to place your template.

If this is unchecked, it will place your new template in every folder
where the original SmartDesign appears. Many SmartDesigns appear in
more than one folder, for cross referencing purposes.

MODIFYING AND DELETING CUSTOM TEMPLATES

Once you have created a new custom template, you can easily edit or
remove it by following these steps:

O Choose New from the File menu, to open the New dialog box.

0 Select the custom template you wish to modify or delete from the list
of SmartDesigns.

® Ifyou wish to edit your template click on the Modify button.

O Ifyou wish to remove your template, click on the Remove button.
This will cause your SmartDesign index to be rebuilt.

MODIFYING AN EXISTING DESIGN JOB

You can also modify an existing design job in case the stock on which
you print it changes. For example, you might have created a business card
using the prepackaged SmartDesigns and now wish to use stock which
includes a horizontal gutter between labels.

To change the layout of an existing design job, choose Page Setup
from the File menu. This will bring up the Custom Page Setup dialog.
Fill in the appropriate fields as described above.

Designs in block(s) differ substantially....

The design is quite diftferent in size than the SmartDesign on which it
was based. This will cause the SmartDesign Layouts to be ineffective for
the new label size. You might want to consider starting the new template
from scratch without SmartDesigns.
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chapter 11 | Creating a Database

SureThing lets you create your own databases for merging with your
Designs, or just for managing and keeping track of your lists of data.

Creating a Database in SureThing is simple— SureThing has simple
data entry forms, where each item, or record, works like a card in a card
file. All you have to do is type the data onto the form.

STARTING A NEW DATABASE

To create a new Database in SureThing:
©® Choose New from the File menu, to open the New dialog box:

SmarDesign: Databazes I

E
Databazes: Fields: el |
= Database Salutation =
: < First Name Help... |
Card File Middle | |
: Last Mame SEACH..
[ Muzgic Albums [ aimars TR
Title
Address One
Address Two
City
State
Zip Code
Country N Mew Window
Phone One
FPhane Two Infarmation. .. |
Fax B
Email Address j

Product Description/Compatibility:
Thiz iz an Address Book database template

® Choose the Databases tab.

©® Double-click the Database folder in the Databases: list to see the
selection of Database Templates available.
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O Click a Database Template to see the list of Fields that are on the
form for that Database.

@ Click OK to open the Create Database Window:

Create Database [ 7]

Save i Iadocs j gI I:_.:

File hame: | Create I
I Databaze [Fred] ﬂ Cancel |
Help |

@ Type a name for the new Database in the Filename: field.

You do not have to type an extension. SureThing adds an MVD
extension automatically.

@ Click Create to open the form for the Database. (We opened the
Address Database).
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The form contains labeled blanks for each piece of data. Each blank is
a Field. The labels are the Field Names. The form is one data Record. A
Database is made up of many of Records.

CHANGING THE FIELD NAMES

Our designers have worked hard to create Database Templates that
contain fields for the most commonly used information. However, we
know that Databases are extremely personal, and that you probably have
your own ideas about what information you want to include. So,
SureThing is flexible, and lets you change the Field Names to suit the
information you want to include in your Database.

Field Names are more than just a way to label the blanks on the
form. The Field Names are also the references for the Fields— when you
want to insert a Field into a Design, you reference the Field Name.
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To change a Field Name:

@ Choose Rename Fields... from the Database menu, or click the Field
Names button on the Control Strip, to open the Rename Field
Labels dialog box.

Rename Field Labels

Mew Label:
— - Dane |
I S alut tior
Field Labels:
First Mame ﬂl
Middle |
Lagt Mame Help... |

Compary Name
Title

® Choose the Field Name you want to change in the Field Labels:
scroll list.

Type the new name for the Field in the New Label: box.
Click Set.

Repeat Steps 2 and 3 for each Field you want to rename.

@ © © o

Click Done to close the dialog box and return to the data entry form,
with the new labels.

ENTERING DATA

To enter data on the form:
©® Move the cursor to the first field, and type the data.
@ Press Tab to move to the next field.

® Type the data in the field.
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O Repeat Steps 2 and 3 until the form is completed. Press Tab and
Shift Tab to move forward and back through the fields, completing
and editing as necessary.

You do not have to complete every Field on the form. Fields left
blank now can be completed at any time, or left empty if not
applicable.

‘When you are finished with the form:

©® Choose Save Record from the Database menu, or click the Save
button on the Control Strip.

® Choose New Record from the Database menu, or click the New
button on the Control Strip.

A blank form appears, for completion of the next record for your
database.

@ Repeat Steps 1 through 6 for all of the records in your Database.

At any time while you are entering records, you can browse through
the records you have created, search for a particular record, edit any of the
records, save records, copy and paste records, resort the records, or
remove records.

SORTING THE DATABASE

Your Database Records are organized in a particular order (sorted). By
default, the Database is sorted alphanumerically by the first field on the
form. Notice that the Status Strip displays the Record Number of the
current Record, and the total number of Records entered.

You can specify that the Records be sorted by any field, in either
ascending or descending order.
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To specify sorting parameters for the Database:

@ Choose Set Sort Field... from the Database menu, or click the Sort
Field button on the Control Strip, to open the Set Sort Fields dialog

box.
Set Sort Fields E
Sort Keps:
Eirst Key:

= - Cancel
Second key IFirst Mame vI
N - Help...
Third K.ey: I Middle | vI

[T Descending

¥

Data can be sorted according to the contents of three difterent fields.
Think of your Phone Book. Names are sorted according to Last
Names. (Aabott comes before Smith, which comes before Zagat.)
Last Name is the First Key. Then, if there are multiple Smiths, they
are sorted according to First Name (Smith, John comes before
Smith, Mary) First Name is the Second Key. Then, if there are
multiple John Smiths, they are sorted according to middle name or
initial. (Smith, John P. comes before Smith, John Q.). Middle Name
is the Third Key.

That’s the way the Phone Book does it, but this is your database.
You can sort your records according to any keys you want.

@ Click the First Key: dropdown menu, and select a Field to be used as
the primary key in sorting your data.

® Click the Second Key: dropdown menu, and select a Field to be used
as the secondary key in sorting your data, or choose None if you only
want data sorted by the field specified as the First Key.

O Click the Third Key: dropdown menu, and select a Field to be used
as the third priority key in sorting your data, or choose None if you
only want data sorted by the fields specified as the First Key and
Second Key.
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@ Click the Descending option if you want the records sorted in
reverse alphabetical or reverse numerical order (from Z to A, or from
100 to 1).

A check mark (0 appears telling you the option is turned on.

@ Click OK to close the dialog box and return to the resorted data
Records.

MOVING THROUGH THE RECORDS

Once you have entered your data, you have a Database made up of a
collection of Records. You need to know how to move through your
database, finding and moving to particular Records when you need to.

You can move through the records you have created one at a time, or
you can skip directly to the first record, or the last record.

There are two ways to move through the records:

»  Click the First 4l , Previous ﬂ, Next ﬂ, or Last M button on the
Control Strip.

LEILAL

or:

» Choose First Record, Previous Record, Next Record, or Last
Record from the Database menu.

You can also skip directly to a particular record, using the Find
feature. Find lets you locate a field by looking for certain text in one field.
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To use Find Record to move to a specific record:

© Choose Find Record from the Edit menu, press Ctrl+F, or click the
Find button on the Control Strip to open the Find Record dialog

box.

Find Record

Search for:

Lagt Mame
Compary Name
Title

® Choose a Field to search from the In Field(s): scroll list.

You can select as many fields as you like in the In field(s): list. Just
click to select a field, click again to deselect it.

® Type the text you want to look for in the specitied fields into the

Search for: box.

® Click OK.

The Search is performed. The first record that contains the specified
text in one of the selected fields is moved to the front.

To continue the Search:

©® Choose Find Next from the Edit menu, Press F3, or Click the Find
Next button on the Control Strip to continue the Search.

COPYING RECORDS

You can easily copy all of the information contained in one record into
another record. This can save you lots of typing time, if you have several
records that contain similar information.



| 83

To copy arecord:
©® Move to the record to be copied.

@ Choose Copy Record from the Edit menu, or click the Copy button
on the Control Strip.

® Move to a New or an Existing Record to paste the data.

O Choose Paste Record from the Edit menu, or click the Paste button
on the Control Strip.

You can probably guess that copying one record into another
existing record replaces the current data in the Paste record with the new
data. Before you copy into an existing record, be sure that the record is

empty, or expendable.

REMOVING RECORDS

You can delete records from your Database.
To remove a record:
©® Move to the record to be deleted.

® Choose Delete Record from the Edit menu, or click the Delete
Record button on the Control Strip.
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appendix A | Keyboard Shortcuts

SureThing provides quick access to many of the commands and dialog
boxes available through the menus. Wherever possible, SureThing
conforms to standard shortcut keys as set forth in the Windows
Guidelines.

With Keyboard Shortcuts you can access commonly used functions
and dialogs, easily move through the document, select and format text.

FILE SHORTCUTS

The following shortcuts are used when working with files:

Ctrl-N Create a new file
Ctrl-0 Open an existing file
Ctrl-S Save the current file
Ctrl-P Print the File

Alt-F4 Exit SureThing

WINDOWS SHORTCUTS

The tollowing shortcuts help manage the windows within SureThing:

F1 Bring up the Windows Help facility
Ctrl-F4 Closes the current document window
Alt-F4 Exits SureThing
Ctrl-F5 Restores the current document window to normal size
Alt-F5 Restores the main SureThing window to normal size
Ctrl-F6 Cycles to the next open document window
Sh-Ctrl-F6 Cydles to the previous open document window
Ctrl-F9 Minimizes the current document window
Alt-F9 Minimizes the main SureThing window
Ctrl-F10 Maximizes the current document window
Alt-F10 Maximizes the main SureThing window
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CLIPBOARD SHORTCUTS

The following shortcuts move selections between documents and the

clipboard.

Ctrl-X
Sh-Del
Ctrl-C
Ctrl-Ins
Ctrl-v
Sh-Ins

Cut the selected text or object to the dipboard

Cut the selected text or object to the clipboard

Copy the selected text or object to the clipboard
Copy the selected text or object to the clipboard
Paste the contents of the clipboard to the document
Paste the contents of the clipboard to the document

CURSOR MOVEMENT SHORTCUTS

The following shortcuts are used for moving the cursor:

Left arrow
Right arrow
Ctrl-Left arrow
Ctrl-Right arrow
Up arrow

Down arrow
Ctrl-Up arrow
Ctrl-Down arrow
Ctrl-9

Ctrl-0

Home

End

Ctrl-Home
Ctrl-End

PgUp

PgDn
Ctrl-PgUp
Ctrl-PgDn

Tab

Sh-Tab

Move to the previous character
Move to the next character
Move to the previous word
Move to the next word

Move to the previous line

Move to the next line

Move to the previous paragraph
Move to the next Paragraph
Move to the previous sentence
Move to the next sentence
Move to the beginning of line
Move to the end of line

Move to the beginning of frame
Move to the end of frame

Move to the previous design
Move to the next design

Move to the first design

Move to the last design

Move to the next frame

Move to the previous frame
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TEXT SELECTION SHORTCUTS

The following shortcuts are used when selecting text:

Sh-Left arrow
Sh-Right arrow
Sh-Ctrl-Left
Sh-Ctrl-Right
Sh-Up arrow
Sh-Down arrow
Sh-Ctrl-9
Sh-Ctrl-0
Sh-Ctrl-Up
Sh-Ctrl-Down
Sh-Home
Sh-End
Sh-Ctrl-Home
Sh-Ctrl-End
Ctrl-A

Select the previous character
Select the next character
Select the previous word
Select the next word

Select the previous line

Select the next line

Select the previous sentence
Select the next sentence
Select the previous paragraph
Select the next Paragraph
Select to the beginning of line
Select to the end of line

Select to the beginning of frame
Select to the end of frame
Select entire text frame

TEXT EDITING SHORTCUTS

The following shortcuts perform standard text editing commands:

Ctrl-Z
Alt-BkSp
BkSp
Del
Sh-Enter
Enter

Undo/Redo the last command or action
Undo/Redo the last command or action

Delete the previous character or selection

Delete the next character or selection

Inserts a line break within the current paragraph
Inserts a paragraph break
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CHARACTER FORMATTING SHORTCUTS

The following shortcuts perform character formatting commands:

Ctrl-B
Sh-Ctrl-B
Ctrl-1
Sh-Ctrl-1
Ctrl-U
Sh-Ctrl-U
Sh-Ctrl-W
Sh-Ctrl-F
Ctrl-P

Apply bold to the selected text

Apply bold to the selected text

Apply Italics to the selected text

Apply Italics to the selected text

Apply continuous underline to the selected text
Apply continuous underline to the selected text
Apply word underline to the selected text

Access the Font drop down on the control strip
Access the Point Size drop down on the control strip

PARAGRAPH FORMATTING SHORTCUTS

The following shortcuts perform paragraph formatting commands:

Ctrl-L
Ctrl-E
Ctrl-R
Ctrl-J
Ctrl-M

Left align the selected paragraphs
Center the selected paragraphs
Right align the selected paragraphs
Justify the selected paragraphs
Access the paragraph dialog box

COMMAND SHORTCUTS

The following are shortcuts are for miscellaneous commands:

Ctrl-F
Ctrl-H
F3
F7

Search for specific text
Search and replace text
Repeat last search or replace
Spell Check
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Accent Browser Control, 13
Adding
Database field to design, 24
Ellipses, 52, 55
Lines, 52, 54
Pictures, 52, 55
Rectangles, 52, 55
Rounded Rectangle, 52, 55
Text Effects, 52, 57
Text Frames, 51, 53
Alignment
Paragraph, 45
Tabs, 48
Text, 40
Alignment problems, 32, 33
All Capitals, 42

B

Bitmap, 51
BMP, 51
Bold, 40, 42
Borders
Paragraph, 47, 49
Browser Controls
Accent, 13
Font, 13
General, 12
Layout, 13
Paper Stock, 12
Point Size, 13
Bullets
Paragraph Attribute, 47, 49
Button Bar, 18

C

Calibrating the printer, 32
Center Aligned Paragraphs, 45
Changing
Database field names, 69
Design, 12
Character Attributes
All Capitals, 42
Bold, 42
Color, 41
Double Underline, 42
Font, 41
Italic, 42
Pitch, 44
Point Size, 41
Small Caps, 42
Spacing, 43
Strike Out, 42
Subscript, 43
Superscript, 43
Underline, 42
Word Underline, 42
Character Spacing, 43
Circle, 55
Clearing tabs, 48
Color
Character, 41
Defining, 41
Comma Delimited Database, 21
Comma Separated Value, 23
Control Strip, 51
Copying
Database records, 74
Designs, 18
Creating a database, 67
CsV, 23
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D

Database
Copying records, 74
Creating, 67
Entering data, 70
Field, adding to design, 24
Finding records, 74
Moving through records, 73
Sorting, 71
Specitying, 22
Database Menu
First Record, 73
Last Record, 73
New Record, 71
Next Record, 73
Previous Record, 73
Rename Fields, 70
Save Record, 71
Set Sort Field, 72
dBASE, 21, 23
DBEF, 23
Default tab width, 48
Deleting
Database records, 75
Designs, 20
Tabs, 48
Design
Creating, 5
Duplicating, 18
Removing, 20
Varying, 12
Design Menu
Delete, 20
Duplicate, 19
Show Item, 15
Design Sets
Moving Around In, 20
Printing, 35
Displaying items, 15
Double Underline, 42

Drawing
Lines, 54
Rectangles, 55
Duplicating
Designs, 18

E

Edit Menu

Copy Record, 75

Delete Record, 75

Find Next, 74

Find Record, 74

Paste Record, 75
Editing

Text, 7
Ellipse

Drawing, 52
Encapsulated PostScript, 51
Entering data into database, 70
EPS, 51

F

Field code, 25
Field Names
Changing, 69
File Menu
Calibrate Printer, 32
New, 5, 67
Print, 27, 33
Printer Setup, 31
Save, 10
Save/Save As, 9
Filename
extensions, 10
limitations, 9
Finding records in database, 74
Font
Browser, 13
Setting, 39, 41



Format Menu
Character, 38, 40, 42
Paragraph, 38, 44
Formatting
Text, 38

G

Graphic
Adding, 51, 52, 55
Placing into Design, 14
Grouped Objects, 59

H

Help
Accessing, 2
In Dialog Boxes, 3
Menu, 3
Horizontal Line, 54

/

Indents, 45
Insert database field, 24
Italic, 40, 42

J

Justified Paragraphs, 45

K

Keyboard
Selecting text, 37
Shortcuts, 77

L

Layout Browser Control, 13
Leader

for tabs, 48
Left Aligned Paragraphs, 45
Lines

Drawing, 52, 54
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Logo
Adding, 52, 55
Placing into Design, 14

M

Merge File

Creating, 67

Specifying, 22
Merge jobs

Printing, 26, 35
Modifying a design, 12
Mouse

Selecting text with, 37
Moving from design to design, 20
MVD, 23

N

New
Design, 5
Numbers
Sequence, 29

0

Object Linking and Imbedding, 52
Object Menu
Tools, 52
OLE Objects
Adding, 52, 58
Overflow, test for, 28

P

Paragraph Attributes
Alignment, 45
Border, 47, 49
Bullets, 47, 49
Character, 46
Indent, 45
Line Spacing, 46
Shades, 47, 49
Space Above, 46
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Space Below, 46 Searching for records in database, 74
Tabs, 47 Selecting
PC Paintbrush, 51 items to display, 15
PCX, 51 text with the keyboard, 37
Picture text with the mouse, 37
Adding, 51, 52, 55 Sequence Numbers, 29
Placing into Design, 14 Serial Numbers, 29
Pitch, 44 Setting
Point Size All capitals, 42
Browser, 13 Bold text, 40, 42
Setting, 39, 41 Character pitch, 44
Printer Character spacing, 43
Calibrating, 32 Database, 22
Creep, 33 Font, 39, 41
Setting Up, 31 Frame alignment, 40
Printing Italic text, 40, 42
Design Sets, 35 Merge File, 22
Merge Jobs, 26, 35 Paragraph alignment, 45
Range of records, 28 Paragraph border, 47, 49
Single Design, 33 Paragraph character attributes, 46
Paragraph indent, 45
R Paragraph shades, 47, 49
Paragraph spacing, 46
Records Point size, 39, 41
Copying, 74 Small capitals, 42
Entering, 70 Strike out, 42
Finding, 74 Subscripted, 43
Sorting, 71 Superscripted, 43
Rectangles Tabs, 48
Drfwving, 52,55 Text alignment, 40
Removing Text color, 41
Database records, 75 Underlined text, 40, 42
Designs, 20 Setting up the printer, 31
Right Aligned Paragraphs, 45 Shades
Rotating Objects, 60 Paragraph, 47, 49
Rounded Rectangles Show Item, 15
Drawing, 52 Small Caps, 42
SmartDesigns
L) Grouped Objects, 59
Savi Sorting the database, 71
aving Spaci
Design, 9 pacng

Character, 43

with a new name, 10 .
Line, 46



Space above paragraphs, 46
Space below paragraphs, 46
Specifying the database, 22
Squares, 55
Strike Out, 42
Super/Subscript, 43

T

Tab key, 7
Tabs
Alignment, 48
Clearing, 48
Default, 48
Deleting, 48
Leader, 48
Setting, 48
Tagged Image File Format, 51
Technical Support
By Fax or Mail, 3
By Phone, 4
Contacting, 3
E-Mail, 3
World Wide Web, 3
Text
Alignment, 40
Bold, 40
Color, 41
Editing, 7
Formatting, 38
Italic, 40
Moving Around In, 7
Selecting with keyboard, 37
Selection with mouse, 37
Text Frame Overflow, 54
Underline, 40
Text Eftects
Adding, 51, 52, 57

Text for overflow, 28

Text Frames
Adding, 51
Growing, 59
Overflow, 54, 59
Sizing, 59

TIFF, 51

Tools
Ellipse, 52
Line, 52
OLE objects, 52
Picture, 52
Rectangle, 52
Rounded Rectangle, 52
Text Effect, 52
Text Frame, 51

/]

Underline, 40, 42
User Information, 7
Utilities Menu
Insert Merge Field, 24
Set Merge File, 22

4

Varying a design, 12
Vertical Line, 54

w

Windows Bitmap, 51
Windows Metafile, 51
WMEF, 51

Word Underline, 42
World Wide Web, 3



